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Description 

A good model is important in a Building Information Modeling (BIM) workflow, and equally 
important is generating a good set of construction documents, complete with detail drawings. 
After mastering basic modeling in Revit software, many users hit the wall and struggle with this 
vital aspect of project delivery. This class will teach you how to bridge the gap between 
modeling and detailing, taking full advantage of the 3D model and adding 2D embellishments 
combined with display modification to create your construction details. This session features 
Revit Architecture. 

 

Speaker 

With a background as a registered architect, Matt Dillon has over 30 years of experience in 
Autodesk Architectural applications and is an Autodesk Certified Instructor at an Autodesk 
Authorized Training Center. In addition to assisting customers implement Building Information 
Modeling (BIM) and Revit Platform products, Dillon has also consulted with Autodesk, Inc., 
development staff in product design and usability for AutoCAD Architecture software. A 
published author, Dillon was one of the recipients of Autodesk's Distinguished Speaker Award in 
2010, and he has been a highly rated instructor at Autodesk University since he first began 
presenting in 2000. 

 

Learning Objectives 

• Determine what to model and what not to model 

• Modify detail view properties to facilitate effective communication of detail 
geometry 

• Modify model geometry to make it useable for construction documents 

• Use detail components, line work and keynotes to finish out the detail 

 



 

 

Page 2 

Introduction 

Much attention is paid in any demonstration or class having to do with Autodesk Revit on the 
modeling process, and downstream uses of the model such as analysis, simulation and 
visualization, among others. To be sure, these are all important; without a model you don’t have 
a project, after all, and all those downstream uses are benefits of the BIM process. Equally 
important, however, is the ability to create construction documents that go beyond the model. 
Unfortunately, many firms choose to forego using the detailing and drafting tools in Revit and 
choose instead to generate their details in AutoCAD. This is a bad idea for at least two reasons. 

• Generating details in AutoCAD separates the detailing process from the Revit workflow, 
creating a disconnect between the model and the construction documents and 
increasing the opportunity for errors and omissions. 

• Generating details in DWG format and then importing/linking those details into the Revit 
model so they can be plotted on sheets in the Revit project can affect the model in 
adverse ways. File size can grow disproportionally to the size of the DWG files being 
imported, and the project file may become unstable. In general, it is not a good idea to 
have a lot of DWG files in a Revit project. 

Admittedly, the drafting and detailing process in Revit is markedly different than AutoCAD’s, and 
that is probably the main reason that firms tend to adopt it last, if at all. However, once the tools 
have been mastered, most users report that they are creating details faster and more accurately 
than they used to in AutoCAD. It just takes a little investment in learning the new tools and 
processes. 

The process of creating a hybrid 3D/2D detail (that is, a detail based partly on the project’s 
model geometry and partly on 2D embellishments) can be broken down into four basic steps or 
processes which this class will address in detail: 

1) Determine what to model and what not to model. Find the best balance between 
model geometry and 2D geometry which, when combined, will give you a valid 
construction detail with the least amount of effort. 

2) Modify Detail View Properties to Facilitate Effective Communication of Detail 
Geometry. This does not mean incorrect geometry. In this step you merely use 
Visibility/Graphics Overrides and other view properties to turn off or crop out parts of the 
model that you do not want to see in the detail. 

3) Modify Model Geometry to Make It Useable for Construction Documents. There are 
usually things in a model that, when viewed at a larger scale, are incorrect. In this step 
you use 2D detailing tools such as Masking Regions and Cut Profiles to either suppress 
them entirely or to modify the way they display themselves in the current view.  

4) Use Detail Components, Line Work and Keynotes to Finish Out the Detail. Once 
the model geometry has been stripped down to just those items that are correct, the rest 
of the detail can be created using 2D Detail Lines, Filled Regions and Detail 
Components. Annotation such as text, tags and dimensions are the finishing touch. 
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Determine What to Model and What Not to Model 

One of the most common mistakes new users of Revit make is to “over-model” – to put too 
much detail in the model. This can cause the model to become inordinately large very quickly 
and can cause you to spend a lot of time on minutiae with little or no payback. It is important to 
realize when it is not appropriate to model an object and when to simply show certain objects in 
a detail as 2D geometry instead. 

As a rule of thumb, you can use the scale of your typical overall floorplans as the first “litmus 
test” as to whether you’re going to model something. In a commercial project for example, your 
floor plan scale is probably around 1/8” = 1’-0” or the equivalent metric scale. If something 
would not normally be seen at that scale you should think twice before modeling it. That doesn’t 
mean you would not model it, but you need to weigh the consequences and effort of modeling 
the object against the benefits and payback. If it is something that might take a long time to 
model and would only be seen in one or two views, for example, then it might be a better idea to 
show it using 2D detailing tools instead. 

In addition, the phase of the project should have an influence as to when you start developing 
your details. While it is perfectly appropriate and, in most cases, advisable to go ahead and start 
calling out your details, and perhaps even placing them on sheets, you may want to forego any 
further development on them until the project has progressed further and is in the Construction 
Documents phase where, hopefully, any major design changes will be few in nature. Otherwise 
you could spend a lot of time chasing changes through your details. Remember, the detailing 
and drafting tools are annotative in nature and therefore are not bi-directionally associative. You 
should consider adjusting your project workflow so that these tools are not heavily used until 
later in the process. 

Finally, the purpose of a given view should be considered when determining how much detail to 
show. For example, in an overall floor plan, consider keeping the detail level set to “Course” to 
eliminate the need to address complex wall cleanup conditions and other conditions best left to 
a detail view. 

In the image below, the overall plan is shown at a course level of detail, using a simple 
architectural column to represent the column enclosure early in the design, then using walls to 
model the actual enclosure as the project progresses. The detail view uses the techniques 
shown in this class to show the actual construction of the condition. 
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Modify Detail View Properties to Facilitate Effective Communication of 
Detail Geometry 

Frequently you will run across items in a detail view that, while correct from a model standpoint, 
don’t lend themselves to the detail, and might confuse the issue somewhat. Some of this 
geometry can simply be turned off using Visibility / Graphics Overrides, however some cannot. 
In the images below there are some items that need to be suppressed for which Visibility / 
Graphics Overrides may not be appropriate. 

 

 

ITEMS THAT NEED TO BE SUPPRESSED WITHOUT USING VISIBILITY/GRAPHICS OVERRIDES 

While it could be argued that the water closet and grab bar could simply be suppressed by using 
Visibility/Graphics overrides, the same cannot be said for the brick lintel and the parapet cap. 
Both of these are sweeps. The parapet cap in particular is a potential challenge, as the portion 
in section needs to remain, however the portion beyond should be suppressed. The difficulty 
here is that they are both the same object. The key for the suppression of all these objects is the 
Clip Depth of the view. Section callouts always take the clip depth of the parent view (the view 
they were created in) as their clip depth, and by default their clip depth remains dependent on 
the parent view. To fix a Callout View such as the two in the preceding image, you can simply 
set the clip depth to be independent, then enter a small value for it; in the example on the 
following page, we used a value of 6”. Anything further than that distance from the section cut 
line will be clipped out of the view. 
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MODIFYING THE CLIP DEPTH OF A SECTION CALLOUT TO SUPPRESS GEOMETRY THAT CANNOT BE 

SUPPRESSED USING VISIBILITY/GRAPHICS OVERRIDES 
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Modify Model Geometry to Make It Useable for Construction Documents 

Frequently views at a scale that is appropriate for a construction detail will reveal errors or 
inaccuracies in the model that are not visible in overall floor plans or building elevations and 
sections.  

 

SEVERAL ITEMS IN THE ENLARGED DETAIL VIEW NEED TO BE CORRECTED 

Rather than attempt to fix these issues in the model, it may be more effective to use one of two 
view-specific modification tools to make the objects appear to be correct in the detail view. 

Masking Regions allow for areas of the model to be masked out in the current view. The borders 
of the Masking Region can be set to “Invisible” so that it appears that there is a blank area in the 
view. Then the correct geometry can be drawn on top of the area using Detail Lines and Detail 
Components. 

 
USING A MASKING REGION TO MASK A PORTION OF THE MODEL IN A VIEW. 
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Masking Regions are a bit drastic, however, and should be used only as a last resort. Usually 
you can use the less destructive Cut Profile tool found on the “View” tab of the ribbon to modify 
the way an object that is being cut in section displays itself in the current view instead. 

 

USING CUT PROFILE TO REMOVE THE STRUCTURAL LAYER OF THE FLOOR FROM THE CURRENT 

VIEW 

 

 

USING CUT PROFILE TO MODIFY THE BRICK / AIR GAP BOUNDARY 
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After using the same Cut Profile tool, the GWB and Stud layers can be modified to be 
represented correctly as well. 

 

MODIFYING THE GWB AND STUD LAYERS USING CUT PROFILE 

It is important to remember that while it may look like you are editing the model using the Cut 
Profile tool, you are merely modifying the way certain model elements display in the current 
view only. 

Use Detail Components, Line Work and Keynotes to Finish Out the Detail 

Once the model elements have been reduced to their bare minimum correct state, it is time to 
start building the detail back up with a variety of view-specific, 2D line work, component and 
annotation tools. 

Detail Components 

Revit comes with an extensive library of 2D Detail Components, and you can create your own 
library of parametric, 2D components as well. While they are 2D and view specific, they are not 
like annotation objects. Since they represent real world physical objects they do not change size 
when the view is scaled.  

 

INSERTING A 2D DETAIL COMPONENT 
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Frequently, positioning the Detail Components can be a bit of a challenge. The best way to do it 
is to consider a group of Detail Components whose positions are interdependent on each other 
to be an assembly. First, insert all the Detail Components in the assembly without worrying 
about their final position. Then begin arranging them together using tools such as Move and 
Align. 

 

IN THE IMAGE ON THE LEFT, THE BEAM AND THE BAR JOIST HAVE BEEN INSERTED, BUT THEY ARE 

NOT IN FINAL POSITION. IN THE IMAGE ON THE LEFT, THEY HAVE BEEN MOVED INTO PLACE USING 

ALIGN AND MOVE. 

The image below shows the detail developed a bit further. Detail Components have been added 
to replace the Ceiling object in the model with more detailed representations of the ceiling tiles 
and ceiling grid. 

 

THE CEILING OBJECT TURNED OFF IN THE CURRENT VIEW AND REPLACED WITH DETAIL 

COMPONENTS 
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Repeating Detail Components 

In addition to Detail Components, you can use Repeating Detail Components to represent 
things that are placed at regular spacings, such as framing members or masonry mortar joints. 
In the current detail the brick veneer on the wall needs to have mortar joints shown. To create a 
Repeating Detail Component for brick mortar joints the process is straightforward. First a Detail 
Component representing a single mortar joint needs to be created. This is done with a simple 
pair of Masking Regions – to mask the brick material fill pattern and to change the profile line of 
the wall to show the shape of the mortar joint, which in this case will be a simple rodded mortar 
joint. The image below shows the Detail Component family for the mortar joint. 

 

THE BRICK MORTAR JOINT DETAIL COMPONENT 

Once the Detail Component has been loaded into the Project it can be used to create a 
Repeating Detail Component. 

 

USING A REPEATING DETAIL COMPONENT TO REPRESENT BRICK MORTAR JOINTS 
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In the image below, the structural deck is represented with another Repeating Detail. 

 

USING A REPEATING DETAIL COMPONENT TO REPRESENT A STRUCTURAL DECK 

Detail Lines 

Detail Lines can be used as a general drafting tool – anytime you simply need to draw a line to 
represent something that you don’t want to model and that you don’t have a Detail Component 
for (or where a Detail Component would not be appropriate). Things like flashing, membranes, 
etc. are good examples of where a Detail Line would be a good idea. 

 

USING DETAIL LINES IN A CONSTRUCTION DETAIL 
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Filled Regions 

Model elements that have been cut in a detail view usually include materials that have their own 
cut patterns. However, some do not, and there are also times when you need to represent 
materials that are not present in the model. For those instances, you can use Filled Regions, 
which are similar to AutoCAD hatch patterns, to do the job. 

 

USING FILLED REGIONS TO REPRESENT MATERIALS 

Insulation 

Revit includes a specific tool for representing batt insulation. This can be used in any plan or 
section view. 

 

THE INSULATION TOOL 
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Detail Groups 

Detail Groups can be used in a situation where an assembly of Detail Components, Detail 
Lines, Annotation and any other 2D, view-specific items needs to be re-used in multiple 
locations or in multiple detail views. Like Model Groups, when a Detail Group is modified, all 
instances of that group are updated. 

Line Work Overrides 

As one of the last steps in fleshing out a detail, you can override line work for graphical clarity. 
The Line Work tool allows you to override the default display of individual lines on a model 
component to make it display the way you want for purposes of graphical presentation in the 
view.  

 

USING THE LINE WORK TOOL TO TOUCH UP THE GRAPHIC DISPLAY 

Again, you should wait until near the end of the project and make a final pass through your 
details to use the Line Work tool. Performing this task too early in the project might very well 
mean that you will be doing it again later after the inevitable changes are made in the model and 
in the details. 

 

THE DETAIL AFTER ALL LINE WORK MODIFICATIONS HAVE BEEN MADE 
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Keynotes  

Revit includes the ability to create automated Keynotes. While this task is fairly easy, there is a 
bit of setup involved, and some understanding of various options and controls is important. 

Associating a Keynote File 

Before you can use the Keynoting feature in Revit, you must first associate your project with a 
Keynote File. To associate a Keynote File, select “Keynoting Settings” from the “Annotate” tab 
of the ribbon. The first item in the dialog is the path to your Keynote File. Note that in the 
example shown it is currently reflecting the default Keynote File, which should be located in your 
Imperial or Metric Library. This is a simple text file which can be edited or created from scratch, 
as we will see later. 

 

ASSOCIATING A KEYNOTE FILE 

Assigning Keynotes to Materials and Elements 

Once you’ve associated the Keynote File to your project or template you can begin to assign 
Keynotes to Material Definitions and Element Types. 

 

ALL MATERIAL DEFINITIONS, COMPONENT AND DETAIL COMPONENT TYPES CAN HAVE A 

KEYNOTE PRE-ASSIGNED TO THEM. 
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Using Keynotes 

You can assign Keynotes to Elements and Materials using one of three options: 

• Element: Pick an element and the Keynote assigned to its Type Definition will be used. If 
no Keynote has been assigned you will be taken to the Keynote File to choose one. This 
will edit the Element Type definition and assign the Keynote to it. 

• Material: Pick a Material in a model component and the Keynote assigned to that 
Material Definition will be used. If no Keynote has been assigned you will be taken to the 
Keynote File to choose one. This will edit the Material definition and assign the Keynote 
to it. 

• User: Pick any element. Whether or not it already has a keynote assigned to it, you will 
be taken to the Keynote File to select any other Keynote that you prefer to use. 

Note that if you accidentally assign the wrong Keynote using the Element or Material options, 
you will need to edit the Element Type definition or Material definition to correct the mistake and 
assign the correct Keynote from the Keynote File. 

 

THE THREE KEYNOTE PLACEMENT OPTIONS AND THE KEYNOTE FILE 

When you use any of the three Keynote options, you are merely using a form of a tag – you can 
customize your own Keynote Tags just as you would any other type of tag, or you can simply 
choose from the tags that are pre-loaded into the default templates. You can also choose 
between two different keynote numbering methods: “By Sheet” and “By Keynote”.  
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CHOOSING THE KEYNOTE NUMBERING METHOD 

Using “By Sheet” will cause Keynotes to be assigned at the time a Detail View has been placed 
on a sheet. Using “By Keynote” will cause Keynotes to be assigned according to the actual 
Keynote Number specified in the Keynote File and that number will be the same on every sheet. 
The numbering method can be changed at any time in the course of a project. Any existing 
details that already have Keynotes assigned will automatically update to the selected method. 

 

THE SAME DETAIL BEFORE BEING PLACED ON A SHEET. ON THE LEFT IS THE EFFECT OF KEYNOTE 

NUMBERING “BY SHEET” AND ON THE RIGHT IS “BY KEYNOTE”. 
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Creating Keynote Legends 

Keynote Legends are similar to a typical Revit Schedule View. There are two fundamental 
differences however: 

• Keynote Legends, because they are technically a form of a Legend View, can be placed 
on multiple sheets. 

• Kenote Legends can be configured to show only the Keynotes that are actually present 
on the sheet that the Keynote Legend instance is placed on. 

Because of those two distinctions, you can use a single Keynote Legend for all the Keynotes in 
your entire project. 

To create a Keynote Legend, select “Keynote Legend” from the “Legends” drop-down menu on 
the “View” tab of the ribbon. The Keynote Legend is almost completely pre-configured for most 
uses. On the initial “Fields” tab, the “Key Value” and “Keynote Text” fields are already included 
in the legend. On the “Sorting and Grouping” tab, the “Sort by” value is already set to “Key 
Value”. The only thing you should have to do is to make sure and check the option to “Filter by 
Sheet” in the “Filter” tab on. This is what causes each instance of the Keynote Legend to only 
show the Keynotes that are on the same sheet as the Keynote Legend instance. 

 

CREATING A KEYNOTE LEGEND. MAKE SURE TO CHECK THE OPTION TO “FILTER BY SHEET” ON IN 

THE “FILTER” TAB. 
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IN THE IMAGE ON THE LEFT, ON DETAIL IS ON A SHEET, WITH THE ASSOCIATED KEYNOTE LEGEND 

INSTANCE. IN THE IMAGE ON THE RIGHT, TWO DETAILS ARE NOW ON THE SHEET AND THE 

KEYNOTE LEGEND INSTANCE HAS GROWN TO SHOW THE ADDITIONAL KEYNOTES ON THE SHEET. 

Customizing a Keynote File 

Although Keynote Files are nothing more than simple text (.txt) files, the best tool to use to 
create or edit them is a spreadsheet editor such as Microsoft Excel. The formatting is a bit 
confusing in the raw text form, but much more readable in spreadsheet form. There are also 
several 3rd party keynote editors available for Revit in the Autodesk App Store. For purposes of 
this document, we’ll focus on Excel. 

When you open the file in Excel (we’ll use the default Imperial Keynotes File as an example), 
make sure to set the file type in the File Open dialog to “all” so that you can see .txt files. After 
selecting the file, choose the “Delimited” option in the Text Import Wizard and select “Next”. In 
the next screen, select “Tab” as the delimiter; you should see a preview of the file in the same 
dialog box. 
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OPENING A KEYNOTES FILE IN MICROSOFT EXCEL. 

Once the file is open in Excel, you should notice that there are three columns. The first column 
is the actual Keynote Number for each note, or the section header for a group of keynotes. The 
second column is the Keynote Text or the section header text. The third column is the reference 
column – it is the section number that the keynote in that row belongs to – this will control how 
the keynotes are organized when viewed in the Keynotes Dialog in Revit.  
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A PORTION OF A KEYNOTES FILE. 

Notice the entry for 02 41 00.B1 in the portion of the Keynote File in the figure above. The 
column on the right indicates that it should fall under subsection 02 41 00, which in turn should 
fall under subsection 02 40 00, which in its turn should fall under Division 02. Rows that do not 
have an entry in the far-right column are considered top-level headers.  

After editing the file, make sure you save it back to .txt format, not the default .xlxs format, and 
you’re ready to go! 

Bonus Section: Creating a Revit Standard Details Library 

The focus of this class is the process of creating a model-based detail. However, that doesn’t 
mean that there is no place for traditional 2D drafted details, completely unrelated to the model, 
in Revit. How many different ways are there to detail a standard interior door jamb, for example? 
Does that really require a model-based detail and callout? Further, most firms that have 
migrated to Revit or that are in the process of migrating to Revit still have a large library of 
AutoCAD standard details that they’d like to continue to use.  

While you can certainly link or import those CAD details into a Drafting View in your Revit 
project, that is not considered a best practice – as explained earlier, too much CAD geometry in 
your project can cause performance and stability problems. Instead, you should consider 
converting those standard details into Revit details. Additionally, any 2D details that you create 
from scratch in Revit can also be saved as standard Revit details for use in a future project. 
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Whether you plan to import an AutoCAD detail and convert it to a Revit Detail or you plan to 
draft it from scratch using the same tools used to embellish a model-based detail, the first step 
is to create a Drafting View. 

 

CREATING A DRAFTING VIEW 

A Drafting View is essentially a blank canvas, completely disassociated from the model, in 
which you can draw 2D geometry. When in a Drafting View all modeling tools are disabled. 

If you are converting an AutoCAD Detail to a Revit Detail, import or link the AutoCAD drawing 
into your Drafting View. Using Detail Lines, Filled Regions, etc., trace over the geometry in the 
AutoCAD Detail. Add Revit text and dimensions to replace the AutoCAD notes and dimensions. 
Once you have finished the conversion, delete the import (and purge the non-referenced 
AutoCAD layers) or remove the link. 

Note: I have seen tutorials that recommend exploding the AutoCAD Detail, then changing the 
line work and text from AutoCAD types to Revit types. I do not recommend this method – it is 
quite possible – in fact probable – that you will miss a few things, meaning you will still have little 
“AutoCAD bits” in your project. Additionally, you will probably find that it is faster to simply trace 
the detail in the first place.  

To properly delete an imported (not linked) CAD Detail, do the following: 

1. Select the CAD geometry. 

2. In the ribbon, select “Delete Layers”. 

3. In the resulting dialog box, choose “Check All” and “OK” 

 

DELETING AN IMPORTED AUTOCAD DETAIL FROM A VIEW. 
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4. From the “Manage” tab of the ribbon, select “Purge Unused”. 

5. Click “Check None”. You may notice that there are still items referenced at the bottom of 
the dialog box. These are the unreferenced AutoCAD object definitions. 

6. Click “OK”. 

 

PURGING UNREFERENCED AUTOCAD OBJECTS. 

However you have chosen to create your 2D Detail, whether by importing and converting an 
AutoCAD Detail or drawing the detail from scratch, you can now save it to a standard Revit 
details library. 

Establishing the Revit Standards Detail Library 

When you are ready to save your first 2D detail to a Revit Standard Details Library, you can use 
the detail itself to establish the library. Simply right-click on the Drafting View in the Project 
Browser and select “Save to New File”. Once you’ve provided a name, a new Revit Project will 
be created with only two views in it: a 3D view that is empty and a copy of your Drafting View. 

 

CREATING A REVIT STANDARD DETAILS LIBRARY FROM A DRAFTING VIEW. 
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Once the Detail Library has been established, future details can be added to it by using the 
“Insert View from File” tool: 

1. Make sure the file with the detail to be added has been saved. 

2. Open the Standard Details Library. 

3. From the “Insert” tab of the Ribbon, select “Insert View from File”. 

4. In the File Dialog, select the project in which you saved the detail. 

5. In the next dialog, choose the details that you want to copy into the Standard Details 
Library and select “OK”. 

6. Save the Standard Details Library. 

 

 

ADDING A DETAIL TO THE STANDARD DETAILS LIBRARY. 

To use any of the standard details in a future project, you use the same “Insert Views from File”, 
only in reverse. 
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Adding a Callout for a Drafting View 

Since Drafting Views are not related to the model in any way, there is no callout symbol created 
for them like there is when you create a Section, Elevation or Callout view. You can reference 
them, however by simply choosing the type of view that they represent (in the case off these 
examples, a Section Detail) and choosing the “Reference Other View” option from the Options 
Bar. 

 

ADDING A CALLOUT TAG FOR A DRAFTING VIEW 

Summary 

The detailing tools and process in Revit are admittedly different than those in AutoCAD, and to 
an experienced AutoCAD user, the 2D drafting tools may seem cumbersome to use. However, it 
is important to remember that in the case of a hybrid detail half or more of the detail is already 
drawn for you before you even start! 

It’s important not to over-model your Revit project, but it is equally important to accurately model 
what you choose to model in 3D to give you the best head start in your detailing process. You 
will find, with time, the list of items that you choose to include in the 3D model will grow as your 
ability to model improves, thereby making your detailing process even easier and quicker. 
Likewise, once you have made the effort to master the detailing process in Revit, you will most 
likely not want to return to doing your details in AutoCAD.  

 


